## Contents

About This Book  7

1 AppSpeed Overview  9
   Access the AppSpeed User Interface  9

2 Viewing Performance Data  11
   About Views  11
      Select an Object  11
      Select a View  11
      Defining the Time Period and Resolution for Data Collection  11
         Define the Time Frame  11
         Set the Time Resolution  12
      View Real-Time Metrics  12
      Performance Tables  12
         Sort Tabular Data  13
         Search for Objects in a Table  13
      Performance Charts and Graphs  13
         Chart and Graph Types  13
         Filter the Graphic Display  14
      Display or Hide Latency Standard Deviation Indicators  14
   Exporting Performance Data  14
      Export Table or Graph Data  14
      Export a Graph as an Image  14
   View Summary Data for Applications and Servers  15
      View Real-Time States  15
      View Unmapped Traffic  15
   View Application Data  16
      View Application States  16
      View Application Properties  16
      Edit Application Properties  16
   View Server Data  17
   View Transaction Data  17
   Performance Indicators  17
      Indicators by View  18
         Performance Indicators in Applications and Servers Views  18
         Performance Indicators in Application Views  19
         Performance Indicators in Server Views  20
         Performance Indicators in Transaction Views  20

3 Working with the Topology Map  23
   Display the Topology Map  23
   Select Map View  23
   Topology Map  24
      Viewing Dependencies  24
      Overview Map Window  24
      Analyze an Object  25
      Locate an Object on the Map  25
4 AppSpeed Administration  27
   Managing Probes  27
      Viewing Probe Information  27
      Install an AppSpeed Probe  28
      Power Probes On or Off  28
      Delete Probes  29
   Configuring AppSpeed with vNetwork Distributed Switching  29
      Configuring AppSpeed to Monitor a vNetwork Distributed Switch  29
         Create a vSwitch for vNetwork Distributed Switches  29
         Create a Port Group  30
         Configure Promiscuous Mode  30
         Configure the AppSpeed Probe to Monitor vNetwork Distributed Switches  30
      Configuring AppSpeed to Monitor Cisco Nexus 1000V Switches  30
         Create a vSwitch for Nexus 1000V Switches  30
         Configure Port Mirroring  31
         Configure the AppSpeed Probe to Monitor Cisco Nexus 1000V Switch  31
   Managing SSL Keys  31
      Add an SSL Key  32
      Update an SSL Key  32
      Extracting SSL Files  32
         SSL Files from an Apache Server  32
         Extract SSL Files from a Microsoft IIS 6.0 Server  32
         Extract SSL Files from a Microsoft IIS 7.0 Server  33
   Managing AppSpeed Licenses  33
      Add a License  34
      Viewing License Details  34
      Remove a License  34
5 Event Management  35
   SLA States  35
   Configuring SLA Thresholds  35
      View Thresholds and Monitoring Settings  36
      SLA Monitoring  36
         Enable or Disable SLA Monitoring of an Application  36
         Enable or Disable SLA Monitoring of Transactions  36
      Setting Thresholds  37
         Define Thresholds  37
         Use AppSpeed Threshold Suggestions  37
      Configure Email Notifications  38
         Enable or Disable Event Notifications  39
      Viewing Events  39
         View Events List  39
         View Event Details  39
         Delete Events  40
6 Upgrading AppSpeed  41
   Overview of the Upgrade Process  41
   Upgrade AppSpeed  41
7 Troubleshooting  43
   AppSpeed Setup Errors  43
   AppSpeed User Interface Loading Problems  44
   General Errors While Using AppSpeed  46
Index 49
About This Book

This book, the VMware vCenter AppSpeed User's Guide, describes the user interface for the VMware® vCenter AppSpeed virtual machine and plug-in.

Intended Audience

This book is intended for IT administrators who use AppSpeed to monitor the performance, usage, and dependencies of multitier applications running across both virtual and physical infrastructure.

This document assumes a basic understanding of VMware management and the VMware VI Client.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your feedback to docfeedback@vmware.com.

Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current versions of this book and other books, go to http://www.vmware.com/support/pubs.

Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on priority 1 issues. Go to http://www.vmware.com/support/phone_support.

Support Offerings

Find out how VMware support offerings can help meet your business needs. Go to http://www.vmware.com/support/services.

VMware Professional Services

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides offerings to help you assess, plan, build, and manage your virtual environment. To access information about education classes, certification programs, and consulting services, go to http://www.vmware.com/services.
AppSpeed Overview

VMware vCenter AppSpeed provides performance management and service-level reporting for applications running within virtual appliances. AppSpeed analyzes the traffic that flows between end users, Web applications, and back-end servers. This analysis provides visibility into multitier applications and enables you to rapidly identify performance issues originating from inadequate resource allocation and application problems.

AppSpeed probes capture traffic to and from the servers on which the probes are deployed on the network. This enables AppSpeed to monitor the real-time end user experience for all transaction requests, breaking down performance from tier to tier. AppSpeed only monitors the traffic on those servers on which AppSpeed probes are deployed.

AppSpeed establishes baselines based on application behavior and compares real-time metrics to service-level targets. In addition, AppSpeed maintains historical monitoring data that you can use to analyze trends over time and for troubleshooting purposes. You can identify which component is responsible for a performance issue and identify the likely solution. You can also configure AppSpeed to generate real-time events in response to transaction-level performance and availability issues. Optionally, email notifications can be sent when events are generated.

AppSpeed includes a wide range of predefined viewing options to facilitate the analysis of performance data. The predefined views incorporate different combinations of data, presented in both tabular and graphic format. Different sets of views are available according to the type of object selected (application, server, or transaction).

Access the AppSpeed User Interface

You access AppSpeed from within the VMware vSphere Client or VMware Virtual Infrastructure (VI) Client.

**NOTE** The first time you access the user interface, AppSpeed prompts you to install the probes. See “Install an AppSpeed Probe” on page 28.

**To access the AppSpeed user interface**

1. In the vSphere Client, click **Home > Solutions and Applications** and click the **AppSpeed** icon.

   In the VI Client, click the **AppSpeed** icon on the toolbar.

   If the **AppSpeed** icon does not appear, verify that the AppSpeed plug-in is selected in the Plugins menu.

2. Select the tab for the required AppSpeed module:

   - **Analysis**: Enables you to view real-time and historical performance data.
   - **Map**: Enables you to view the location of a specific application, server, or transaction on your network topology map, as well as the relationships between the monitored objects. The default map view focuses on applications, showing the connections between applications and the servers on which they operate.
   - **Administration**: Enables you to perform various administrative functions, including installing and deploying probes, configuring SSL keys and mail notification settings, and adding or editing AppSpeed license keys.
This chapter describes how to display performance data for applications, servers, and transactions in the Analysis module, and outlines the types of data presented in each of the predefined views.

This chapter includes the following topics:

- “About Views” on page 11
- “View Summary Data for Applications and Servers” on page 15
- “View Application Data” on page 16
- “View Server Data” on page 17
- “View Transaction Data” on page 17
- “Performance Indicators” on page 17

About Views

The AppSpeed Analysis module has several predefined views that enable you to view different cross-sections of performance data in a variety of ways.

For details on the indicators displayed by each of the predefined views, see “Performance Indicators” on page 17.

Select an Object

The AppSpeed inventory tree lists the applications and servers detected on the network.

If you select the root directory, the information displayed reflects the overall status of all of the applications and servers. To display information for a specific application or server, select the object in the inventory tree.

Select a View

The available views vary according to the type of object selected on the AppSpeed inventory tree.

On the Analysis page, select the name of the view from Analysis Views drop-down menu.

Defining the Time Period and Resolution for Data Collection

Define the Time Frame

You can define the time period for which performance data is displayed. You can specify the start and end times and dates, or you can view data for a time period, such as the previous month. You can also display the data in specific units of time, such as weekly or hourly.
To define a specific date
1. From the Select Time Frame drop-down menu in the view settings bar, select Manual.
2. Click From to specify the start date and time.
3. Select the start date and click OK.
4. Click To to specify the end date and time.
5. Select the end date and click OK.
   The time frame of the data displayed is adjusted accordingly.

To define a time period
Under Select Time Frame in the view settings bar, select the time period from the drop-down menu.
For example, to view performance data for the past 12 hours, select Last 12 Hours.

Set the Time Resolution
You can set the time resolution of the displayed data, meaning that you can view the breakdown of data according specific units of time, such as by week, day, hour, or minute. For example, an hourly time resolution graphs the data across the hours of a day (0 to 23).

To set the time resolution
1. Under Select Time Frame in the view settings bar, click By.
2. From the drop-down men, select the time unit.
   For example, an hourly time resolution graphs the data across the hours of a day (0 to 23).
   If data is not available for the selected time unit, AppSpeed sets the largest unit available for the selected time frame.

View Real-Time Metrics
You can view real-time metrics for the selected objects in the Info Panel. The types of information displayed vary according to the object type. The data displayed reflects the performance for the past five minutes.

In the Applications and Servers view, the Info Panel displays the throughput and the level of SLA compliance. It might also include information on the number of applications, servers, or transactions and their respective latency and SLA states.

To display the Info Panel, click Show Info Panel in the upper right corner of the main display area.
To hide the Info Panel, click Hide Info Panel in the upper right corner of the main display area.

Performance Tables
One way to view performance data is in tables. The tables displayed depend on the selected view and object type (application or server).

Each table is displayed on a separate tab. A dedicated row appears at the bottom of each tab, showing summary data for the object selected on the inventory tree. This row does not change from tab to tab.

The following icons appear adjacent to the object name and indicate if the item is selected in the table:

- The item is selected.
- The item is not selected.

You can perform a variety of actions on the tabular display data:

- View data on the chart for specific applications, servers, or transactions.
- Drill down a specific application, server, or transaction to view additional data.
Sort the table.
- Search for specific applications or servers.
- Highlight the data for a specific object on the corresponding graph, by selecting its row in the table.
- Export the data into a CSV file.

**Sort Tabular Data**

You can sort tabular data according to a specific parameter.

**To sort data:**
1. Click the corresponding column header.
2. Click again to reverse the sort order.

**Search for Objects in a Table**

You can search for objects in a table. The search criteria are applied to all cells in the displayed table.

**To search for an object**
1. In the tabular display pane, click Q.
2. In the Search text box, enter your search criteria and click Q.
   - The objects that match the search criteria are highlighted in the table.
3. To navigate between the results, click to move to the next entry or click to move to the previous entry.
4. To cancel the search and clear the highlighting of table entries, click the Clear button.

**Performance Charts and Graphs**

The graphs and charts displayed depend on the selected view and object type.

You can perform a variety of actions from the graphic display pane:
- Filter the displayed data.
- Show or hide latency standard deviation indicators on the graph.
- Export the graph or the graph data.

**Chart and Graph Types**

The following graphs and charts are available:

<table>
<thead>
<tr>
<th>Chart/Graph Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability</td>
<td>Reports trends in error behavior for the selected period of time and selected object type.</td>
</tr>
<tr>
<td>Baseline Comparison</td>
<td>Shows the average usage and latency for either applications or servers, with the corresponding baseline (Applications and Servers view only).</td>
</tr>
<tr>
<td>Latency</td>
<td>Displays the latency behavior during a selected period of time.</td>
</tr>
<tr>
<td>Latency Breakdown</td>
<td>Reports the end-to-end latency breakdown in a chart for the selected application or transaction. The content of this chart is not linked to your selections in the tabular display area.</td>
</tr>
<tr>
<td>Usage vs. Latency</td>
<td>Compares the latency and usage behaviors for the selected object type.</td>
</tr>
</tbody>
</table>
Table 2-1. Charts and Graph Types (Continued)

<table>
<thead>
<tr>
<th>Chart/Graph Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Throughput Breakdown of Servers</td>
<td>Reports the breakdown of throughput for servers for the selected application or transaction.</td>
</tr>
<tr>
<td>Usage</td>
<td>Reports the utilization during the selected period of time for the objects selected in the display area.</td>
</tr>
</tbody>
</table>

For details on the performance indicators shown in each of the charts and graphs, see “Performance Indicators” on page 17.

Filter the Graphic Display

You can view data for specific objects in the chart or graph.

To filter the data, select or deselect the check boxes in the table in the lower portion of the data display pane.

**NOTE**  You cannot filter the latency breakdown and throughput breakdown graphs.

Display or Hide Latency Standard Deviation Indicators

Latency indicators, sometimes referred to as “whiskers,” illustrate the standard deviation for latency on graphs in some of the views. By default, this feature is turned off.

**To display or hide latency standard deviation indicators**

In the tabular display pane, click 

You can view the standard deviation values in tooltips.

Click 

again to hide the latency indicators.

Exporting Performance Data

You can save performance data in other formats for further viewing and analysis in external applications.

Export Table or Graph Data

You can export performance data into a comma-separated value (CSV) file.

**To export the data**

1 In the tabular display pane, click 

2 Name the file and select the location, and click **Save**.

Export a Graph as an Image

You can save the currently displayed graph as an image (PNG).

**To export the graph as an image**

1 In the tabular display pane, click 

2 Name the file and select the location, and click **Save**.

**To export the graph data**

1 In the tabular display pane, click 

2 Name the file and select the location in which you want to save the file, and click **Save**.

The date is saved in a CSV file in the specified location.
View Summary Data for Applications and Servers

You can view summary performance data for all the applications and servers on the network in one several predefined views.

To view summary data for the entire network
1 On the AppSpeed inventory tree, select Applications and Servers (the root node).
   The data shows the performance of all the applications and servers monitored by AppSpeed, according to the Applications: Baseline Comparison view.
2 To view the total number of servers and applications, and the throughput and level of SLA compliance, click the Analysis page to view the Info Panel.
   The data displayed reflects the performance for the last five minutes.
3 (Optional) Select a different view from the Analysis Views drop-down menu.
4 (Optional) To view summary data in the graphic display pane for only some of the applications or servers, deselect the check boxes for the objects for which you do not want to include data.

View Real-Time States

You can view the real-time values of performance indicators for all applications or for the transactions of a selected application based on their performance in the last 10 seconds.

The tabular display pane of the States page lists the following state-related parameters:

- **State**: Current state of the application or transaction.
- **Latency state**: SLA state for latency.
- **Error state**: SLA state for errors.
- **Average latency**: Average measured time between the start of the client request to the end of the server reply since the onset of the current state.
- **Average errors**: Average rate of errors since the onset of the current state.
- **Average hits**: Average number of hits per second since the onset of the current state.
- **Since**: Time when the state change occurred.

To view real-time state data
Click States on the page selection bar.

To view the States page, you must select Applications and Servers or a specific application on the inventory tree.

View Unmapped Traffic

You can view the unmapped servers and transactions detected on the network. Unmapped objects have not yet been mapped to specific servers or applications.

**NOTE** The number of unmapped objects typically decreases as AppSpeed maps the environment.

To view unmapped traffic
1 In the navigation tree, select Applications and Servers.
2 Click Unmapped Traffic on the page selection bar.

You must configure the SSL keys for each endpoint where AppSpeed detects SSL traffic in order to view unmapped traffic on HTTP sites that incorporate SSL protection. See “Managing SSL Keys” on page 31.
3 View the status information for the unmapped traffic.

- **Name**: Name of the server or transaction.
- **Endpoint**: IP address and ports used by the server (Servers tab only).
- **Latency**: Average and standard deviation (STDEV) latency rates for the server or transaction.
- **Hits**: Average number of hits per second for the server or transaction, and the total number of hits in the specified timeframe.
- **Throughput**: Average throughput for the server or transaction, and the total throughput in the specified timeframe.
- **Errors**: Average rate of errors, as a percentage, for the server or transaction.

**View Application Data**

You can view information on a specific applications, such as its properties, threshold settings, real-time states, and generated events.

**To display detailed data for a single application**

1. Select the application in the navigation pane.

   The data display pane displays data based on the Usage vs. Latency view.

   **NOTE**: To return to the previous data display, click the Back icon on the toolbar.

2. (Optional) To change the application view, select a view from the Analysis Views drop-down menu.

**View Application States**

You can view real-time metrics for the selected application, including throughput, hits, latency, errors, and SLA levels in the Analysis page Info Panel. The data displayed reflects the performance for the last five minutes.

**Table 2-2** describes the icons used to represent the application states.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>The application's performance complies with set SLA and latency thresholds.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>The application is in Warning state.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>The application does not comply with the terms of the SLA.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>The application is not available.</td>
</tr>
</tbody>
</table>

**View Application Properties**

You can view the general properties of the selected application, including its name and application roots.

**To view/edit the application properties**

On the page selection bar, click **Properties**.

**Edit Application Properties**

You can edit the name of the application.

**To edit the application name**

1. On the page selection bar, click **Properties**.

2. Edit the text in the **Name** text box and click **Update**.
View Server Data

You can view performance analysis data for a server and its related objects (servers, applications, and dependent servers), including charts and tables.

To display detailed data for a single server

1. Select the server in the navigation pane.
   
   The data display pane displays data based on the Usage vs. Latency view.

   **NOTE** To return to the previous data display, click the Back icon on the toolbar.

2. (Optional) To change the server view, select a view from the Analysis Views drop-down menu.

View Transaction Data

You can view transaction data, such as its properties and events generated.

To display transaction information

1. In the navigation pane, select the application for which you want to view a transaction.

2. In the tabular data pane, select the Transactions tab.
   
   The data display pane display data based on the Usage vs. Latency view.

   **NOTE** To return to the previous data display, click the Back icon on the toolbar.

3. (Optional) To change the transaction view, select a different view from the Analysis Views drop-down menu.

4. To view information about the transaction, such as its name, transaction roots or the or the application to which it belongs, click Properties on the page selection bar.

   **NOTE** The full name of the transaction varies according to transaction type; for example, a URL is displayed for an HTTP transaction, whereas a full database query is displayed for a database transaction.

Performance Indicators

AppSpeed monitors the following performance indicators. The performance indicators displayed vary according to the selected view.

**Table 2-3.** AppSpeed Performance Indicators

<table>
<thead>
<tr>
<th>Performance Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Latency</td>
<td>Measured time between the start of the client request to the end of the server reply, averaged across all hits in the given time frame. A larger value means a slower server response.</td>
</tr>
<tr>
<td>Average Reply Size</td>
<td>Average size, in bytes, of a single server reply, averaged across all hits in the given time period.</td>
</tr>
<tr>
<td>Average Throughput</td>
<td>Average number of reply bytes per second in the given time period.</td>
</tr>
<tr>
<td>Error Percentage</td>
<td>Percentage of error hits as a portion of the total hits in the given time period.</td>
</tr>
<tr>
<td>Execution Time</td>
<td>Sum of all latencies in the given time frame. This value reflects the total amount of time of all server replies in the given time frame.</td>
</tr>
<tr>
<td>Hit Rate</td>
<td>Average number of hits per second in the given time frame.</td>
</tr>
<tr>
<td>Latency Baseline</td>
<td>Average latency of all hits in the last year.</td>
</tr>
</tbody>
</table>
Table 2-3. AppSpeed Performance Indicators (Continued)

<table>
<thead>
<tr>
<th>Performance Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latency Breakdown</td>
<td></td>
</tr>
<tr>
<td>- Application</td>
<td>The latency measured from the time the server receives the first packet of the request until it starts to transmit the reply.</td>
</tr>
<tr>
<td>- Infrastructure</td>
<td>The latency measured from the time the server starts transmitting the reply until fully replying to the client's request.</td>
</tr>
<tr>
<td>- Network (RTT)</td>
<td>The average round-trip time, without failures, from client to server.</td>
</tr>
<tr>
<td>- Network Overhead</td>
<td>The cost of packet retransmissions, errors and drops.</td>
</tr>
<tr>
<td>Latency STDEV</td>
<td>The standard deviation of the latency of all the hits in the given time frame.</td>
</tr>
<tr>
<td>Max. Latency</td>
<td>The latency of the slowest hit in the given time frame.</td>
</tr>
<tr>
<td>SLA percentage</td>
<td>The percentage of hits that were not errors and which had latency within SLA levels.</td>
</tr>
<tr>
<td>Total Errors</td>
<td>The total number of hits identified as errors in the given time frame.</td>
</tr>
<tr>
<td>Total Hits</td>
<td>The total number of hits in the given time frame.</td>
</tr>
<tr>
<td>Total Throughput</td>
<td>The total number of reply bytes in the given time frame.</td>
</tr>
</tbody>
</table>

Indicators by View

The type of object selected on the AppSpeed inventory tree determines the available views and the performance indicators included in each view.

Performance Indicators in Applications and Servers Views

Table 2-4 lists the performance indicators included in the views available when **Applications and Servers** is selected on the AppSpeed inventory tree.

**NOTE** A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-4. Performance Indicators in Applications and Servers Views

<table>
<thead>
<tr>
<th>Performance Indicator</th>
<th>View Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Applications: Baseline Comparison</td>
</tr>
<tr>
<td>Average Latency</td>
<td>+</td>
</tr>
<tr>
<td>Latency Baseline</td>
<td>+</td>
</tr>
<tr>
<td>Latency STDEV</td>
<td>+</td>
</tr>
<tr>
<td>Hit Rate</td>
<td>+</td>
</tr>
<tr>
<td>Total Hits</td>
<td>+</td>
</tr>
<tr>
<td>Average Throughput</td>
<td>+</td>
</tr>
<tr>
<td>Total Throughput</td>
<td>+</td>
</tr>
<tr>
<td>Average Reply size</td>
<td>+</td>
</tr>
<tr>
<td>Endpoint</td>
<td>+</td>
</tr>
</tbody>
</table>
### Performance Indicators in Application Views

Table 2-5 lists the performance indicators included in the views available when an application is selected in the AppSpeed inventory tree.

**NOTE** A plus (+) sign indicates that the performance indicator is shown in the view.

#### Table 2-5. Performance Indicators in Application Views

<table>
<thead>
<tr>
<th>Performance Indicator</th>
<th>Usage vs. Latency</th>
<th>Slowest Transact.</th>
<th>Latency Over Time</th>
<th>Latency Breakdown</th>
<th>Most Used Transact.</th>
<th>Usage Over Time</th>
<th>Throughput Breakdown of Servers</th>
<th>Availability Over Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Latency</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Latency STDEV</td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max Latency</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hit Rate</td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total Hits</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Average Throughput</td>
<td>+</td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Total Throughput</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total Errors</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Error Percentage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Execution Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Reply Size</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Application Infra-structure</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network (RTT)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Network Overhead</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>
Performance Indicators in Server Views

Table 2-6 lists the performance indicators included in the views available when a server is selected on the AppSpeed inventory tree.

**NOTE** A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-6. Performance Indicators in Server Views

<table>
<thead>
<tr>
<th>Performance Indicator</th>
<th>View Name</th>
<th>View Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Usage vs. Latency</td>
<td>Applications Latency</td>
</tr>
<tr>
<td>Average Latency</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Latency STDEV</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Max Latency</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Hit Rate</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total Hits</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Average Throughput</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total Throughput</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Total Errors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Percentage</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Execution Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Reply Size</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Application</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Infrastructure</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Network (RTT)</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Network Overhead</td>
<td>+</td>
<td></td>
</tr>
</tbody>
</table>

Performance Indicators in Transaction Views

Table 2-7 lists the performance indicators included in the views available when a transaction is selected on the AppSpeed inventory tree.

**NOTE** A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-7. Performance Indicators in Transaction Views

<table>
<thead>
<tr>
<th>Performance Indicator</th>
<th>View Name</th>
<th>View Name</th>
<th>View Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Usage vs. Latency</td>
<td>Latency Over Time</td>
<td>Latency Breakdown</td>
</tr>
<tr>
<td>Average Latency</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Latency STDEV</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Max Latency</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Hit Rate</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Total Hits</td>
<td>+</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Average Throughput</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Total Throughput</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Errors</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Percentage</td>
<td>+</td>
<td></td>
<td>+</td>
</tr>
<tr>
<td>Performance Indicator</td>
<td>View Name</td>
<td>Usage vs. Latency</td>
<td>Latency Over Time</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Execution Time</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Reply Size</td>
<td>+</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Infrastructure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network (RTT)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Overhead</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This topology map shows the relationships between the applications and servers detected on the network, as well as the dependencies between applications.

This chapter includes the following topics:

- “Display the Topology Map” on page 23
- “Topology Map” on page 24

Display the Topology Map

You can view the default map by selecting the Map module. Alternatively, while viewing application or server data in the Analysis module, you can directly access the map, which in turn focuses on the selected object.

To display the topology map

- Click the Map tab. By default, the map view focuses on applications.

To display the topology map from an application view

- In the Info Panel, click the Find Application on Topology Map link.
  
  The selected application is centered on the topology map.
  
  By default, the Application Focused view is selected.

To display the topology module from a server view

- In the Info Panel, click the Find Application on Topology Map link.
  
  The selected application is centered on the topology map.
  
  By default, the Server Focused view is selected.

Select Map View

The Topology Map can be displayed in either of the following viewing modes:

- **Application Focused**: Applications are centered and lines are drawn from each application to its servers.

- **Server Focused**: Servers are centered and lines are drawn from each server to its applications.
  
  To select a view, select the corresponding option on the map toolbar.
Topology Map

The topology map is displayed in the Map module and includes application and server objects.

The following object types are represented on the topology map:

- Application (the type of application appears below the icon)
- Server (the IP address of the server appears below the icon)

The SLA state of each application is indicated by the appearance of additional icon:

- Warning
- Above SLA
- Not available

The absence of an additional icon indicates that the state is OK.

Lines indicate the relationships between applications and servers, based on the selected map view. If the view focuses on applications, then each application is centered with lines connecting it to the servers on which the application runs. If the view focuses on servers, each server is centered and lines connect it to the applications run on it. Dependencies are indicated by dashed orange lines.

Viewing Dependencies

You can view the dependencies between objects on the map. The type of relationships displayed depends on the object at the center of the map. Dependencies are indicated by dashed orange lines.

- When the focus is on an application, showing the dependencies displays the connections between the different applications.
- When the focus is on a server, showing the dependencies displays the connections between the different servers.

To display the object dependencies, select the Show Dependencies check box.

To hide the object dependencies, clear the Show Dependencies check box.

Overview Map Window

The Overview Map window displays a miniature view of the map area. It enables you to select and zoom in on a specific area on the map, or adjust the overall scale of the map by zooming in and out.

To view the topology map using the Overview Map window.

1. Select the Show Overview map check box.
   - To hide the Overview Map window, clear the Show Overview Map check box.

2. To focus on a specific area, select the area and drag the selection box around the relevant area in the miniature map.

3. To zoom in, click on the map scale bar.
   - To zoom out, click on the map scale bar.

4. To adjust the zoom to fit the content, click on the map scale bar.
Analyze an Object

You can select an object on the topology map and view its details in the Analysis page.

To display the analysis information for a map object

1. Select the object on the topology map.
2. Click Analyze.

The Analysis page for the selected application or server is displayed.

Locate an Object on the Map

You can search for an object on the topology map.

To locate an object on the map

- Type the name of the object (or part of it) in the text box and click .

The first object that matches is selected on the map.

To locate the next object that matches the name, click Show Next.
You can perform various administrative functions in AppSpeed, including adding and deleting the probes that AppSpeed uses to monitor vSwitches, configuring SSL keys and mail notification settings, and adding or editing AppSpeed license keys.

This chapter includes the following topics:
- “Managing Probes” on page 27
- “Configuring AppSpeed with vNetwork Distributed Switching” on page 29
- “Managing SSL Keys” on page 31
- “Managing AppSpeed Licenses” on page 33

**Managing Probes**

Before the monitoring process can begin, you must install at least one AppSpeed probe on one or more hosts. Each probe can monitor up to three vSwitches. You can install more than one probe on the same host to monitor additional vSwitches.

You initially configure the probe settings, including the management network, storage device, and specific vSwitches to monitor, as part of the probe installation process. After that, you can add and remove probes as needed.

**NOTE** To configure the AppSpeed probe to monitor a vNetwork distributed switch, see “Configuring AppSpeed with vNetwork Distributed Switching” on page 29.

**Viewing Probe Information**

You can view the current probe configuration details.

**To view probe information**

1. Click the Administration tab at the top of the AppSpeed user interface to display the Administration module.
2. In the navigation pane, click **Probe Management**.
   
   The Probe Management window displays the existing host clusters and hosts and the probes installed on them in a hierarchical format.
Install an AppSpeed Probe

You can install a probe on one host at a time, or you can install a probe on multiple hosts at the same time.

To install a probe

1. In the Probe Management window, select the check box for one or more hosts or clusters on which to install a probe and click Install Probe.

A probe is installed on each selected host, regardless of whether another probe is already installed on the host.

**NOTE**  When you select the check box for a cluster, the check boxes for each host that it contains are selected. Similarly, when you select a host, any probes already installed on it are selected.

The Probe Installation window displays a separate entry for each host that you select. Each entry appears in a separate pane.

**NOTE**  When you install a probe in AppSpeed, distributed vSwitches do not appear in the Probe Installation window. To monitor these switches, you must configure the AppSpeed probe. See “Configuring AppSpeed with vNetwork Distributed Switching” on page 29.

2. (Optional) Configure the probe for each host entry.
   a. Type the name of the probe in the Probe Name text box.
      If you do not specify a name, the AppSpeed server assigns a default name.
   b. From the Storage drop-down menu, select the storage device to which the probe connects.
   c. From the Management Network drop-down menu, select the network to use to manage the probes:
      - Select DHCP to use dynamic address settings.
      - Select Static IP to set a fixed IP address for the network management card. Enter the IP address and netmask details. Optionally, enter the gateway details.
      - Select up to three monitoring vSwitches. The vSwitches sniff traffic on the configured management network. By default, the first three available vSwitches are selected.

3. (Optional) To add an additional probe to a host, click ![Install another probe on this host] at the bottom of the host entry and configure the probe as described in Step 2.

4. When you are done adding host-probe combinations, click Install Probes.

5. Review the installation information, and click OK.

Alternatively, click Back to return to change any of the settings.

The installation progress is indicated in the Probe Status column in the Probes Management window.

Upon completion, the new probe is added to the All Probes folder in the VI client. The probe is powered on and set up.

Power Probes On or Off

You can power probes on or off from the Probe Management window.

To power probes on or off

In the Probes Management window, select the check boxes for one or more probes, and click Power On or Power Off.
Delete Probes

If you do not want to monitor the traffic on a specific host, you can remove the probes from that host.

To delete probes from hosts

1. In the Probes Management window, select the check boxes for one or more probes on the same or multiple hosts, and click Delete Probe.
2. Click OK to confirm.

The probe is removed from the selected hosts only.

Configuring AppSpeed with vNetwork Distributed Switching

When you install a probe in AppSpeed the distributed switches do not appear in the Probe Installation window. You must manual configure AppSpeed to monitor these switches.

This chapter includes the following topics:

- “ Configuring AppSpeed to Monitor a vNetwork Distributed Switch” on page 29
- “Configuring AppSpeed to Monitor Cisco Nexus 1000V Switches” on page 30

Configuring AppSpeed to Monitor a vNetwork Distributed Switch

If only vNetwork Distributed Switches are configured in the vCenter or if all other vSwitches are already being monitored by other probes, you need to create a new vSwitch before you deploy the probe.

Create a vSwitch for vNetwork Distributed Switches

You can create a new vSwitch for the vNetwork Distributed Switches.

To create a vSwitch

1. In the vSphere Client or VI Client, select Home > Hosts and Clusters.
2. Select the destination host on which you want to install the probe.
4. In the Connection Type window, select the Virtual Machine option and click Next.
5. Deselect the check boxes for the NICs and click Next.
6. Name the vSwitch in the Network label text box, set the VLANID to 4095, and click Next.
7. Click Finish.
8. Deploy the AppSpeed probe in the Probe Installation window, selecting the new vSwitch for management and monitoring.

NOTE If your management network is set to the fake vSwitch, and the Failed to obtain an IP address error message is displayed after the probe deployment completes.

9. After the probe deployment completes, right-click the probe, select Edit Settings, and set the management network and monitor network as required.
10. Restart the probe guest.

NOTE After the probe loads, it continues to appear as failed in the user interface; however, it functions correctly.
**Create a Port Group**
If you deploy a vNetwork Distributed Switch, it is recommended that you add a new port group.

**To create a port group**
1. In the vSphere Client or VI Client client, select **Home > Networking**.
2. Create a new port group for the vNetwork Distributed Switch:
   a. Select the vNetwork Distributed Switch.
   b. From the Basic Tasks list, create a new port group.

**Configure Promiscuous Mode**
You must configure the vNetwork Distributed Switch ports to work in promiscuous mode so that the AppSpeed probe can monitor the switch.

To configure promiscuous mode for the port group.
1. In the vSphere Client or VI Client, select **Home > Networking**.
2. Right-click the corresponding port group in the vNetwork Distributed Switch and select **Edit Settings**.
3. Select **Security**.
4. Set the **Promiscuous mode** to **Accept**.
5. Save your changes.

**Configure the AppSpeed Probe to Monitor vNetwork Distributed Switches**
Once the probe is deployed, you can configure the AppSpeed probe to monitor the distributed vSwitches.

**To configure a probe to monitor a vNetwork distributed switch**
1. In the vSphere Client or VI Client, select **Home > Hosts and Clusters**.
2. Right-click the corresponding port group in the distributed vSwitch and select **Edit Settings**.
3. Select **Security**.
4. From the **Network** drop-down menu, select the relevant port group (by default, dvPortgroupX).
5. Verify that both the **Connected** and **Connect at power on** check boxes are selected.

**Configuring AppSpeed to Monitor Cisco Nexus 1000V Switches**
If only Nexus 1000V switches are configured in the vCenter or if all other vSwitches are already being monitored by other probes, you need to create a new vSwitch before you deploy the probe.

**Create a vSwitch for Nexus 1000V Switches**
You can create a new vSwitch for the Nexus 1000V switches.

**To create a switch**
1. In the vSphere Client or VI Client, select **Home > Hosts and Clusters**.
2. Select the destination host on which you want to install the probe.
3. Select **Configuration > Networking > Add Networking Wizard**.
4. In the Connection Type window, select the **Virtual Machine** option and click **Next**.
5. Deselect the check boxes for the NICs and click **Next**.
6. Name the vSwitch in the **Network label** text box, set the VLANID to **4095**, and click **Next**.
7. Click **Finish**.
Deploy the AppSpeed probe in the Probe Installation window, selecting the new vSwitch for management and monitoring.

NOTE If your management network was set to the fake vSwitch, and the Failed to obtain an IP address error message is displayed after the probe deployment completes.

After the probe deployment completes, right-click the probe, select Edit Settings, and set the management network and monitor network as required.

Restart the probe guest.

NOTE After the probe loads, it continues to appear as failed in the user interface; however, it functions correctly.

Configure Port Mirroring
You must configure port mirroring on the Cisco Nexus 1000V vSwitch ports so that the AppSpeed probe can monitor a Nexus 1000V vSwitch.

To configure port mirroring
1 Set the server ports that you want to monitor as the source ports.
2 Set the unused ports as destination ports.
3 Enable port mirroring on the switch.

Configure the AppSpeed Probe to Monitor Cisco Nexus 1000V Switch
After the probe is deployed and set up, you can configure it to monitor the Nexus 1000V switches.

To configure the AppSpeed probe to monitor a distributed vSwitch
1 In the vSphere Client or VI Client, select Home > Hosts and Clusters.
2 Right-click the corresponding port group in the Nexus 1000V and select Edit Settings.
3 Select the required network adapter.
4 From the Network drop-down menu, select the relevant port with port mirroring configured.
5 Verify that both the Connected and Connect at power on check boxes are selected.

Managing SSL Keys
For AppSpeed to monitor traffic on HTTPS sites that incorporate SSL protection, you must configure the SSL keys for each endpoint (IP address and port pair) where AppSpeed detects SSL traffic.

To view SSL key information
1 Click SSL Management in the navigation pane of the Administration module.
2 View the secure site endpoints for which AppSpeed cannot monitor traffic without a key.
   - The Pending SSL Endpoints table lists the endpoints for which valid SSL keys are required, including their IP addresses and ports. AppSpeed automatically identifies the SSL endpoints for which keys do not exist.
   - The Monitored SSL Endpoints table lists the endpoints for which valid keys exist in AppSpeed, including the respective server name, where available, and IP address and ports. AppSpeed monitors traffic on these endpoints.

NOTE AppSpeed supports the configuration and monitoring of SSL keys for HTTPS sites only.
Add an SSL Key

You can assign a key to a pending endpoint to enable AppSpeed to actively monitor its traffic.

To add an SSL key:

1. In the SSL Management window, select the check boxes for the endpoints in the SSL Pending Endpoints table and click Add/Update SSL key.
2. Browse to and open the key file.

The key is assigned to the selected endpoints. The endpoint moves from the SSL Pending Endpoints table to the Monitored Endpoints table.

Update an SSL Key

You can update the SSL key assigned to an endpoint, for example, to replace an older key with a new one.

To update an SSL key:

1. In the SSL Management window, select the check boxes for the endpoints in the Monitored Endpoints table and click Add/Update SSL key.
2. Browse to and open the new key file.

The new key replaces the key previously assigned to the selected endpoints.

Extracting SSL Files

You can extract the SSL files from the Web server to obtain the SSL keys. The procedure varies according to the type of Web server.

SSL Files from an Apache Server

You can extract the SSL files from an Apache server.

To extract SSL files from an Apache Server:

1. In the Apache conf directory, open the http.conf file. The filename is either /etc/httpd/conf.d/ssl.conf or /etc/httpd/conf/httpd.conf.
2. Locate the SSLCertificateKeyFile command on the SSL site.
3. Save a copy of the file that appears under SSLCertificateKeyFile as [cluster].key and transfer it to the vSphere Client machine.

You can select and upload the key file to the AppSpeed server (see “Add an SSL Key” on page 32).

Extract SSL Files from a Microsoft IIS 6.0 Server

You can extract the SSL files from a Microsoft IIS 6.0 server.

To export the IIS key file:

1. Select Start Programs > Administrative Tools > Internet Information System (IIS) Manager.
2. Expand the COMPUTERNAME (local computer) tree in the left pane, and then expand the Web Site tree.
3. Right-click Default Web Site and select Properties.
4. Select the Directory Security tab, and then select the Server Certificate button.
5. Select Next, select Export the current certificate to a PFX file, and select Next again.
6. Select a file for the exported certificate and key to be written, and select Next.
7 Enter the password with which the key is to be encrypted.
   During the export process, a password is requested to protect the key. If a password is assigned, remember this password. This password is required when importing the key into AppSpeed.
8 Re-enter the password in the Confirm Password text box.
9 Select Finish.

The PFX file should be transferred to the vSphere Client machine and uploaded to the AppSpeed server (see “Add an SSL Key” on page 32).

Extract SSL Files from a Microsoft IIS 7.0 Server

This section describes how to extract the SSL files from a Microsoft IIS 7.0 server.

To export the IIS 7.0 key file
1 Select Start Programs > Administrative Tools > Internet Information System (IIS) Manager.
2 Expand the COMPUTERNAME (local computer) tree in the left pane and then double-click the Server Certificates icon in the middle pane.
3 Right-click the certificate and select Export.
   A PFX file is created.
   During the export process, a password is requested to protect the key. If a password is assigned, remember this password. This password is required when importing the key into AppSpeed.
   The PFX file should be transferred to the vSphere Client machine and uploaded to the AppSpeed server (see “Add an SSL Key” on page 32).

Managing AppSpeed Licenses

You must have an AppSpeed license to monitor servers.

To view existing licenses
1 Click the Administration tab at the top of the AppSpeed user interface to display the Administration module.
2 In the navigation pane, click Licensing to display the License page.
   The total number of licensed processors (all licenses combined) and the number of monitored processors are displayed at the top of the page.
   The following details are displayed for existing licenses:
   - **Key**: The license key string.
   - **Processors**: The maximum number of physical chips on physical hosts that have virtual machines monitored by AppSpeed.
   - **Expiration Date**: The date on which the license will expire.
   - **Time to Expiration**: The number of days left before the license expires.
   - **Validated**: Indicates whether or not the license key has been validated.
   Expired licenses appear in red.
Add a License

You can add additional licenses, for example, if you want to implement AppSpeed monitoring on additional servers not covered by existing licenses.

To add a license

1. In the License page, click Add License.
2. Enter the license key provided by VMware in the text box and click OK.

NOTE: If the license key string is not valid, an error message is displayed immediately above the license key list. Check the license key and try again.

Viewing License Details

You can view the details of an existing license, including the allowed number of servers, the date the license was issued, the date the license is scheduled to expire, and the number of days left until that expiry date.

To view the license details

1. In the License page, select a license key and click View License.
2. Click OK to return to the License page.

Remove a License

You can remove an existing AppSpeed license.

NOTE: If you remove a valid license, the number of allowed processors decreases accordingly.

To remove a license

1. In the License page, select a license key and click Remove License.
2. When prompted to confirm the deletion, click OK. The license is removed. If the license had not yet expired, the number of allowed processors decreases accordingly.
You can monitor Service Level Agreement (SLA) compliance based on the performance of applications and transactions. AppSpeed monitors these latency and error thresholds for transactions. When a threshold is exceeded, AppSpeed generates an event.

You can manually monitor events or you can configure AppSpeed to send email notifications whenever an event is generated.

This chapter includes the following topics:

- “SLA States” on page 35
- “Configuring SLA Thresholds” on page 35
- “Configure Email Notifications” on page 38
- “Viewing Events” on page 39

### SLA States

AppSpeed uses state changes to generate events. The state of a transaction is based on its compliance to the defined latency and error thresholds.

The state of an application reflects the worst state of any of its transactions. For example, if the state of all the transactions is OK, the state of the application is OK. If the state of any transaction is Not Available, the application state is Not Available.

**NOTE** You can view the real-time states for all applications or for the transactions of a selected application. See “View Real-Time States” on page 15.

### Configuring SLA Thresholds

You can define the levels at which state changes occur in response to fluctuations in performance as measured by latency and the percentage of errors. You configure thresholds per transaction.

When a performance level exceeds a defined threshold, a change in state occurs. Specific thresholds are defined for each state based on the degree of an application’s compliance with or deviation from target SLA levels. The transition between states occurs based on the thresholds defined for warning, SLA violation, and unavailable states for the given transaction.

You can enable or disable performance monitoring per application or per transaction. See “Enable or Disable SLA Monitoring of Transactions” on page 36.
View Thresholds and Monitoring Settings

You can view the thresholds and SLA monitoring settings.

To view threshold and monitoring settings

1. In an application view, click Threshold Settings on the page selection bar.
2. If SLA Monitoring is enabled, you can view the monitored transactions

A separate entry appears for each transaction, including:

- **Modified**: If a change is made in the settings for the transaction but not applied, a flag icon appears.
- **Name**: The name of the transaction and an icon indicating its state. Separate rows appear for Latency and Errors immediately below each transaction name.
- **Monitor**: An On or Off icon indicates whether AppSpeed monitors thresholds and generates events for the transaction.
- **Warning**: The threshold for the respective warning state, if defined.
- **SLA**: The threshold for the respective SLA violation state, if defined.
- **Unavailable**: The threshold for the respective unavailable state, if defined.
- **Average**: The average performance level for the selected time frame.
- **Updated**: The date and time of the last threshold settings update.

SLA Monitoring

You can enable or disable SLA monitoring per application or per transaction. When disabled, thresholds are not monitored and events are not generated for state changes.

Enable or Disable SLA Monitoring of an Application

If you enable SLA monitoring for an application, it is enabled for the application and for all of its transactions. If you disable SLA monitoring, you cannot set SLA thresholds for its transactions.

To enable SLA monitoring for an application

1. In the Threshold Settings page for the application, select SLA Monitoring Enabled.
2. From the Sensitivity drop-down menu, select the sensitivity of state changes in response to detected deviations in performance levels, based on the number of hits and their persistence over time.
   - **High**: Trigger a state change within a minute of detecting the onset of deviations.
   - **Medium**: Trigger a state change after detecting the onset of deviations that persist for 5 minutes or longer.
   - **Low**: Trigger a state change after detecting the onset of deviations that persist for 30 minutes or longer.
3. (Optional) Click Go to Mail Notification Settings to configure AppSpeed to send email notifications regarding state changes (see “Configure Email Notifications” on page 38).

To disable SLA monitoring for an application

In the Threshold Settings page for the application, select SLA Monitoring Disabled.

Enable or Disable SLA Monitoring of Transactions

You can enable or disable SLA monitoring for specific transactions. To monitor a transaction, SLA monitoring must be enabled for the application to which it belongs.

Disabling SLA monitoring does not remove any saved threshold settings, however the transaction is no longer monitored for changes in performance levels based on those thresholds.

**NOTE** If SLA monitoring is disabled for an application, you cannot enable monitoring of its transactions.
To enable or disable monitoring for a specific transaction

In the Threshold Settings table, click the On or Off icon in the row for the performance threshold.

To enable or disable monitoring for all transactions:

On the Threshold Settings toolbar, click Monitor All or Unmonitor All.

Setting Thresholds

The threshold value determines the performance level that triggers a change in the state of a transaction or application. For each transaction, you can define thresholds for latency and errors. You can specify threshold values or have AppSpeed suggest values based on performance trends over time.

Define Thresholds

You can set the SLA thresholds for latency and errors for a specific transaction.

To manually define thresholds

1. In the Threshold Settings page for the application, select the row for the performance threshold (Latency or Errors).

   The threshold settings are shown in the Threshold pane below the table. The transaction’s performance relative to the thresholds is indicated on the accompanying graph. The thresholds are indicated by color-coded lines. A black line indicates the performance trend for the defined time period.

2. Type the threshold value in the state field (Warning, SLA, or Unavailable).

   When the threshold value is exceeded, the transaction status changes to the selected state.

   The threshold line on the graph is adjusted according to your setting so that you can view the performance data relative to the proposed threshold.

   **NOTE** To revert to the previously saved values, click Revert.

3. When you have completed setting the thresholds, click Update Table.

   The values are updated in the Threshold Settings table.

4. Click Apply Changes to accept the changes.

Use AppSpeed Threshold Suggestions

You can have AppSpeed suggest threshold values based on performance trends over time. AppSpeed can suggest values for all thresholds for all application transactions or only for those thresholds for which no values exist.

If you suggest threshold settings for all transactions, you can still disable monitoring for specific transactions.

To suggest values for all thresholds

1. In the Threshold Settings page for the application, click Suggest for All on the toolbar.

   A progress bar is displayed while the process is performed, which might take several minutes.

   When the process is complete, any previously set values in the Threshold Settings table are overwritten by the suggested values. A flag icon next to the transaction name indicates that it is overwritten.

   **NOTE** To revert to the previously saved values, click Revert All.

2. To edit a suggested value for a specific transaction, select the row for the performance threshold (Latency or Errors) and edit the value in the corresponding state field (Warning, SLA, or Unavailable), as described in “Define Thresholds” on page 37.

3. Click Apply Changes to the save the values in the Threshold Settings table.
To suggest values for undefined thresholds
1. In the Threshold Settings page for the application, click Suggest for Undefined on the toolbar.
   A progress bar is displayed while the process is performed, which might take several minutes.
   When the process is complete, any previously set values in the Threshold Settings table are overwritten
   by the suggested values. A flag icon next to the transaction name indicates that it is overwritten.

   NOTE: To revert to the previously saved values, click Revert All.

2. To edit a suggested value for a specific transaction, select the row for the performance threshold (Latency
   or Errors) and edit the value in the corresponding state field (Warning, SLA, or Unavailable), as described
   in “Define Thresholds” on page 37.

3. Click Apply Changes to the save the values in the Threshold Settings table.

Configure Email Notifications
You can configure AppSpeed to send email notifications regarding events to one or more email addresses.
An email notification includes a one line summary of each generated event. The notification settings are
configured globally and are identical for all monitored applications.

To configure email notifications
1. In the navigation pane of the Administration module, click Mail Notification Settings.
   You can also click Go to Mail Notification Settings in the application Threshold Settings page.

2. Select the Send mail notifications for events check box.

3. In the Recipient addresses text box, type the email address to which to send notifications and click Add.
   You can add additional email addresses as needed.

4. In the SMTP server section, select how to route email messages:
   If you select Forward all mails to the following smart host, enter the address of the smart host in the
   adjacent text box.

5. In the Outgoing Mail Definitions section, configure the following parameters:
   ■ Sender Account: The email account from which event notification messages are to be sent.
   ■ Mail Subject: The subject text to appear in event notifications.
   ■ Interval between Mails: The interval, in seconds, between the sending event notifications. During
     the interval, event notifications are accumulated and then sent as a single email notification.

6. In the DNS Server section, type the preferred and alternate DNS server details in the respective text boxes
   or select the Acquire Automatically check box.

7. (Optional) Click Send test mail to verify the accuracy of the email addresses.

8. Click Apply.

To remove an email address from the notifications list
1. In the navigation pane of the Administration module, click Mail Notification Settings.

2. In the Recipient addresses list, select the email address that you want to remove and click Remove.

3. Click Apply.
Enable or Disable Event Notifications
Disabling event notifications allows you to temporarily suspend email notifications, without affecting the notification configuration settings.

To enable or disable notifications
1. In the navigation pane of the Administration module, click Mail Notification Settings.
2. Select or clear the Send mail notifications for events check box and click Apply.

Viewing Events
The Events List includes the events generated in the specified time period. Table 5-1 describes the parameters included in the Events List.

Table 5-1. Event List Parameters
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Event ID</td>
</tr>
<tr>
<td>Time</td>
<td>Time when the event was generated</td>
</tr>
<tr>
<td>Type</td>
<td>Type of object for which the event was generated (transaction or application)</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the object for which the event was generated</td>
</tr>
<tr>
<td>Event Type</td>
<td>Type of event: Latency or Error percentage</td>
</tr>
<tr>
<td>From State</td>
<td>State of the object before the event was generated</td>
</tr>
<tr>
<td>To State</td>
<td>Updated state of the object for which the event was generated</td>
</tr>
</tbody>
</table>

When the root directory is selected in the navigation pane, only application events are displayed in the Events List tab.

View Events List
1. To view the events for a specific application, select the application on the AppSpeed inventory tree and click Events on the page selection bar.
2. To move forward or backward within the specified time period, click Next Day or Previous Day, respectively.
3. To hide transaction-specific events, deselect the Show Transactions check box.
   To display the transaction-specific events, select the Show Transactions check box.
4. To view events per transaction, select the transaction in an Application view and click Events on the page selection bar.

View Event Details
You can view the details of a single event, including the key performance indicators of the object for which the event was generated. This information includes the time when the event occurred and performance indicators.

For a description of the performance indicators, see “Performance Indicators” on page 17.

To view event details
In the Events List page, double-click the event.

When applicable, links to suggested actions are displayed in the Next Steps pane.
Delete Events

You can delete events from the Events List at any time.

To delete events

In the Events List page, select the events and click Delete.
If a new version of AppSpeed is available, you can upgrade to that version.

This chapter includes the following topics:

- “Overview of the Upgrade Process” on page 41
- “Upgrade AppSpeed” on page 41

Overview of the Upgrade Process

The AppSpeed upgrade process uses an ISO image and is fully automated. The ISO image is provided by VMware.

You upgrade AppSpeed by connecting the ISO image with the new version to the AppSpeed server machine and running a command-line interface (CLI) command. The CLI command performs the following actions:

1. Upgrades the AppSpeed server and performs two sequential reboots.
2. Sets up the AppSpeed server with the new version, keeping all configurations and monitoring data of the previous version.
3. Creates a recovery virtual machine snapshot on the AppSpeed server machine to which you can revert at any time.
4. Creates a backup copy of all the configuration and monitoring data to enable the upgrade to restore existing data.
5. Distributes the upgraded version to all probes.

You can observe the progress of the AppSpeed server upgrade and set up processes from the console. You can observe the redeployment of the probes in the AppSpeed user interface.

Upgrade AppSpeed

You upgrade AppSpeed version using the ISO image provided by VMware.

To upgrade AppSpeed

1. Save the ISO file provided by VMware to a location on your network.
2. In the vSphere Client or VI Client, connect the AppSpeed server to the ISO file.
   a. Select the AppSpeed server machine in the inventory tree.
   b. Click Connect CD/DVD and select Connect to ISO image from the drop-down menu.
   c. Browse to the location of the ISO file.
3. Log in to the AppSpeed server console as the console user.
4. From the default console shell, run the command upgrade_AppSpeed.
5 Press Enter to run the upgrade script.
   The upgrade process reboots the AppSpeed server and recreates all AppSpeed probes. This can take up to 20 minutes.

   **NOTE** If an error occurs during the script execution, an error message appears indicating the nature of the error.

   After the AppSpeed server boots from the ISO image, it continues the upgrade process. This process can take up to one hour.
   When the process is complete, the ISO image reboots the system and starts a second upgrade script.
   A message appears indicating that the AppSpeed server upgrade is complete.
   You are prompted to disconnect the ISO file.

6 Disconnect the ISO file in the Client.
   The script recreates the probes in the new version. You can monitor the redeployment process from the AppSpeed Probes Deployment window.

7 Verify the redeployment of the probes.
If you encounter problems when using AppSpeed, use this troubleshooting information to try and resolve the problem.

This chapter includes the following topics:

- “AppSpeed Setup Errors” on page 43
- “AppSpeed User Interface Loading Problems” on page 44
- “General Errors While Using AppSpeed” on page 46

**AppSpeed Setup Errors**

If you have problems while setting up AppSpeed, try these troubleshooting suggestions.

**Problem**

Setup fails and the following error message appears:

*Connection timed out. Verify the vCenter address and try again.*

**Cause**

You entered an incorrect vCenter Server IP address during setup.

**Solution**

1. Verify the accuracy of the vCenter Server IP address.
2. Run setup again and enter the correct IP address.

**Problem**

Setup fails and the following error message appears:

*Connection timed out. Verify the vCenter address and try again.*

**Cause**

The vCenter HTTPS Web Service port is not configured to work with the default port 443.

**Solution**

1. Check the vCenter Web Service port.
2. Run setup again and enter `<vCenter_IP>:<HTTPS_Port>` in the vCenter parameters section.

**Problem**

Setup fails and the following error message appears:

*Connection timed out. Verify the vCenter address and try again.*
Cause
The vCenter HTTPS Web Service port is blocked to traffic between the AppSpeed server and vCenter Server.

Solution
1. Verify with IT that the vCenter HTTPS Web Service port on the firewall is open from the AppSpeed server to vCenter Server.
2. Run setup again.
3. If the problem persists, try running Telnet to the vCenter IP with the vCenter HTTPS Web Service configured to port 443 to verify that the port is open.

Problem
The following error message appears:

The remote server returned an error: Server Unavailable

Cause
The vSphere Client or VI Client uses HTTP to download the AppSpeed user interface from the AppSpeed server. If the firewall between the vSphere Client or VI Client and the AppSpeed server is closed for port 80, the download fails.

Solution
1. Verify that port 80 is open on the firewall.
2. If the problem persists, log in to the AppSpeed server virtual machine as the console user and run restart_AppSpeed.

Problem
The following error message appears:

The application failed to initialize properly, click OK to terminate the application.

Cause
A problem occurred in the AppSpeed server.

Solution
1. Log in to the AppSpeed server virtual machine as the console user.
2. From the console, run restart_AppSpeed.

AppSpeed User Interface Loading Problems
If you have problems loading the AppSpeed user interface, try these troubleshooting suggestions.

Problem
After clicking the AppSpeed plug-in Download and Install link, the following message appears:

The remote server returned an error: (404) Not Found.

Cause
The AppSpeed plug-in fails to install if vCenter is not configured to work with port 80.

Solution
1. Manually download the setup.exe file from:
   http://<vCenter_IP>:<HTTPS_Port>/AppSpeed/static/setup.exe
2. Run the setup.exe file. (Close the vCenter before performing the installation)
3 On the machine running the vCenter Client, go to C:\Program Files\VMware\Infrastructure\Virtual Infrastructure Client\Plugins\AppSpeed.

4 Open the Settings.config file in a text editor.

5 Replace the line <!--ConductorURL>http://<hostname>/</ConductorURL--> with the line: <ConductorURL> http://<vCenter_IP>:<HTTPS_Port>/AppSpeed/</ConductorURL>.

6 Replace the line <VCProxyNamespace>AppSpeed</VCProxyNamespace> with <!--VCProxyNamespace>AppSpeed</VCProxyNamespace-->.
   For example, for vCenter 1.2.3.4 and port 8080, use: <ConductorURL>http://1.2.3.4:8080/AppSpeed/</ConductorURL>.

7 Save and close the file.

8 Restart the vSphere Client or VI Client and enable the AppSpeed plug-in in the Plugin tab.

**Problem**

You click the AppSpeed icon in the vSphere Client or VI Client, but the AppSpeed view does not load.

**Cause**

A connection to the server cannot be established or there is an issue with proxy settings. This type of error is usually preceded by one of the following messages: Received a connectivity error or URL Error received.

**Solution**

1 Log in to the AppSpeed server virtual machine as the console user.

2 From the console, run restart_AppSpeed.

3 Verify with IT that port 80 is open on the firewall.

4 Restart the vSphere Client or VI Client.

5 Wait a few minutes for the AppSpeed user interface to load.

6 If the user interface still does not load, reinstall the user interface from the plug-in window.

**Problem**

The following error appears in the user interface:

Unable to communicate with AppSpeed server: failed to download UI module from http://<vCenter address>/AppSpeed, consult your system administrator.

**Cause**

An HTTP connection to the AppSpeed server is refused due to certificate authorization issues.

**Solution**

1 In Internet Explorer or Firefox, go to http://<AppSpeed server IP>.
   A message appears indicating that the server’s certificate must be approved before the machine allows HTTP connections.

2 Approve the certificate using the Web browser.

3 Restart the VI Client.

4 Click the AppSpeed button.
If the problem persists, go to http://<AppSpeed server_ip>/AppSpeed/static/setup.exe and download setup.exe from the AppSpeed Brain.

If you succeed, the server is accessible.

If the problem persists and the 503 Service Unavailable message appears, log in to the AppSpeed server virtual machine as the console user and run restart_AppSpeed from the console.

Problem
The user interface cannot connect to AppSpeed.

Cause
Storage used by the AppSpeed server was disconnected for a while causing the file system to respond as a read-only file system.

Verify the cause by logging into the console on the AppSpeed virtual machine and running commands such as start_AppSpeed or restart_AppSpeed. The resulting error message will indicate that the file system is read-only. For example, a message similar to the following one might appear:

OS Error: [Error 30] Read-only file system: 'twistd.pid'

Solution
1 Validate that the storage is up.
2 From the vSphere Client or VI client, reboot the AppSpeed server’s virtual machine to reinitialize the file system.

General Errors While Using AppSpeed

If you have problems while using AppSpeed, try these troubleshooting suggestions.

Problem
One of my virtual machines is not in the AppSpeed Inventory Tree.

Cause
No AppSpeed probe is configured to monitor the virtual machine.

Solution
1 Verify that an AppSpeed probe is running and located together with the virtual machine on the same host.
2 In the Host networking configuration, verify that the AppSpeed probe is connected to the vSwitch that the virtual machine uses for traffic handling.

Cause
The virtual machine is not displayed because SSL private keys need to be loaded.

Solution
1 In the Analysis module, select Applications and Servers in the inventory tree.
2 Click Unmapped Traffic on the page selection bar.
3 Click the Servers tab and search for the virtual machine.

A low number of hits indicates that the virtual machine is not yet mapped.
Solution

1. In the user interface, select **SSL Management** in the Administration module and verify that the server appears on the list.

2. If the server is on the list, load the corresponding private keys.
   
   See "Managing SSL Keys" on page 31.

Problem

I do not see my application in the AppSpeed user interface.

Solution

1. In the Analysis module, select **Applications and Servers** in the inventory tree.

2. Select **Unmapped Traffic** on the page selection bar.

3. Click the **Servers** tab, and search for the server that runs the application under the relevant protocol.

   A low number of hits indicates that the application is not yet mapped. In the **Transactions** tab, you can see any transactions that are not mapped to an application due to a low number of hits.

4. If the server is not discovered, verify that AppSpeed probe is running and connected to the same vSwitch that the server uses for traffic handling.
Index

A
access AppSpeed 9
Analysis module
   define time frame 11
   inventory tree 11
   view charts and graphs 13
Analysis Views
   select 11
analyze objects 25
Application Focused view 23
Application views
   components 16
   performance indicators 19
applications
   enable or disable monitoring 36
   real-time states 15
   SLA state 35
   view details 16
   view properties 16
Applications and Servers views 15
   performance indicators 18
AppSpeed
   access 9
   upgrade 41
   views 11
AppSpeed probes, See probes
availability 13

B
baseline
   comparison 13

C
charts
   filter 14
   types 13
   view 13
Cisco Nexus 1000V, See Nexus 1000V switches
configure notifications 38

D
dependencies, show on map 24
distributed switches
   configure probe 30
   create port group 30
   create vSwitch 29
   promiscuous mode 30
DNS server 38

E
enable or disable monitoring
   applications 36
errors
   set thresholds per transaction 37
   total 18
event notifications
   configure 38
   disable 39
   enable 39
events
   configure notifications 38
   delete 40
   manage 35
   view properties 39
Events List
   parameters 39
   transaction-specific 39
export
   graph data 14
   table data 14

F
file system
   read-only 46

G
graphs
   export data 14
   filter 14
   types 13
   view 13
H
Home view 15
performance indicators 18

I
install probes 28
inventory tree 11

L
latency
maximum 18
standard deviation 18
standard deviation indicators 14
latency breakdown 13
application 18
infrastructure 18
network 18
license
add 34
remove 34
view 27, 33
view details 34
locate objects on map 25

M
Mail Notification Settings 38
mail notifications, See notifications
Map module 9
display 23
locate objects 25
object icons 24
view dependencies 24
Microsoft IIS 6.0 server 32
Microsoft IIS 7.0 server 33
Monitor All 37
monitoring
enable or disable for applications 36
sensitivity 36
view settings 36

N
Nexus 1000V switches
configure probe 31
create vSwitch 30
port mirroring 31
notifications
configure 38
recipient addresses 38
remove email address 38

O
objects
analyze 25
locate on map 25
outgoing mail definitions 38
Overview Map window
adjust zoom to fit content 24

P
performance indicators
Application views 19
Applications and Servers views 18
Server views 20
Transaction views 20
port groups 30
port mirroring 31
probes
configure for vNetwork distributed switches 30
configure to monitor Nexus 1000V 31
install 28
manage 27
view configuration 27
promiscuous mode 30
properties
applications 16
events 39

R
Real-Time States page 15
Revert All 37, 38

S
search
in tables 13
objects on map 25
select view 11
Server Focused view 23
Server views
components 17
performance indicators 20
servers
unmapped 15
view data 17
SLA
configure thresholds 35
percentage 18
state changes 35
states 35
view thresholds 36
SLA monitoring
enable or disable for applications 36
sensitivity 36
SLA states
  applications 35
  transactions 35
  transition between 35
SMTP 38
SSL keys
  edit 32
  extract from Apache server 32
  extract from Microsoft IIS 6.0 server 32
  extract from Microsoft IIS 7.0 server 33
standard deviation indicators 14
Suggest for All 37
Suggest for Undefined 38

T
  tables
    export data 14
    search 13
    sort data 13
threshold settings
  parameters 36
  view 36
thresholds
  configure 35
  manually define 37
  set 37
  suggest 37
  suggest for all 37
  suggest for undefined 38
throughput
  average 17
  total 18
time frame
  define 11
  relative to past 12
time resolution 12
topology map 24
  adjust zoom to fit content 24
  Application Focused view 23
dependencies 24
icons 23
locate objects 25
object icons 24
overview map 24
Server Focused view 23
total errors 18
total hits 18
total throughput 18
Transaction views
  performance indicators 20
transactions
  set thresholds 37
  SLA state 35
  unmapped 15
troubleshooting
  general 46
  inventory tree 46
  read-only file system 46
  setup errors 43
  user interface loading problems 44
U
unmapped traffic
  parameters 15
  view 15
Unmonitor All 37
upgrade AppSpeed 41
user interface
  troubleshooting loading problems 44
V
view data
  applications and servers 15
  unmapped traffic 15
views, See Analysis Views
vNetwork distributed switches, See distributed switches
vNetwork Distributed Switching 29
vSwitch
  create for Nexus 1000V 30
  create for vNetwork distributed switch 29
  monitor 27